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This chapter takes you on a tour of AutoCAD and provides an overview of the
different components of the AutoCAD screen. It teaches you about AutoCAD’s
drawing environment, how to start commands, and how to open existing

drawings. As you will see, AutoCAD provides many different ways to accomplish
the same task. For example, to activate a command, you can select it from a menu or
a toolbar, or type the command name at AutoCAD’s command prompt.

There is no right or wrong way to do something in AutoCAD. As you become more
familiar with the program, you will develop techniques that you find most comfortable
for the way you work and the types of drawings you create. Once you become
proficient, you may want to customize AutoCAD for your particular needs. There are
also many common drafting tasks that can be automated by using scripts and macros,
or by writing or purchasing add-on applications that run inside AutoCAD, tailoring
the program for specific drafting and design disciplines. While this book will not teach
you how to write custom programs, you will learn how to customize many AutoCAD
features and utilize third-party add-ons.

AutoCAD’s open architecture enables it to be customized to suit your individual
needs, and once you have used it for a while, you’ll be able to make the most of its
amazing capabilities. But we’re getting a bit ahead of ourselves. First, let’s learn the
basics. This chapter explains the following concepts:

■ Starting AutoCAD

■ Understanding the AutoCAD interface

■ Selecting commands

■ Correcting mistakes

■ Getting online help

■ Opening existing drawings

■ Working with multiple drawings

■ Using Partial Open and Partial Load

■ Saving your work

■ Exiting from AutoCAD

Starting AutoCAD
This chapter assumes that you have already installed AutoCAD. If you are going to
work in AutoCAD as you follow along in this book, you should install AutoCAD now,
before proceeding. Installing AutoCAD 2002 is quite simple, particularly compared to
earlier versions of the program. An easy-to-use Setup program guides you through
the AutoCAD installation process, transferring the files from the CD-ROM to a folder
it creates on your hard disk. The Setup program also creates a menu item on the
Windows Start menu, and a shortcut icon on your desktop. If you need additional help
installing AutoCAD, see Appendix C.
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You can start AutoCAD by choosing it in the Start menu or by double-clicking the
AutoCAD 2002 icon on the Windows desktop. To start AutoCAD from the Start menu,
choose Start | Programs | AutoCAD 2002 | AutoCAD 2002.

The first time you start AutoCAD, the program displays the Authorization wizard, in
which you provide the authorization code to unlock your copy of AutoCAD. You register
your copy of AutoCAD and obtain this authorization code from Autodesk, either via the
Web or by e-mail, phone, fax, or mail. If you elect to authorize AutoCAD at this time, the
wizard guides you through the process, offering options such as connecting to Autodesk’s
registration web site, automatically generating an e-mail message, displaying the proper
phone numbers, or printing a registration form that you can fax or mail to Autodesk. If
you decide to defer this process until a later time, you can begin using AutoCAD now.
You have 15 days from the first time you start AutoCAD in which to register and
authorize your copy. The Authorization wizard appears every time you start AutoCAD
until you have registered your copy and obtained your authorization code. Once you
obtain the code, write it down and save it along with your AutoCAD 2002 CD-ROM,
in case you ever need to reinstall the software.

When you start AutoCAD, the program displays the AutoCAD 2002 Today
window. This window provides tools to help you start a new drawing, load symbol
libraries, access an online bulletin board for design collaboration within your company,
and use the Autodesk Point A design portal. You’ll learn more about this window
later in this chapter (see Figure 1-17). For now, click the Close button to dismiss the
AutoCAD 2002 Today window.

The AutoCAD 2002 Today window serves as the default startup dialog box whenever you
start AutoCAD or begin a new drawing. If you prefer, you can reconfigure AutoCAD to
use a more traditional style startup dialog box, similar to the one used in earlier versions,
by changing the Startup setting on the System tab of the Options dialog box.

Understanding the AutoCAD Interface
The AutoCAD screen is divided into six distinct areas:

■ Title bar

■ Menu bar

■ Toolbars

■ Document window or drawing area

■ Command window

■ Status bar

Figure 1-1 shows the typical layout of the AutoCAD screen. Most of these
components are standard Windows features. For example, the title bar along the
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top of the window shows the name of the program, AutoCAD 2002. The name of the
current drawing (or “Drawing1,” if the current drawing has not been saved) appears
in the title bar of the document window. Each open drawing has its own document
window. If the document window has been maximized, the name of the current
drawing appears in the main AutoCAD window title bar, enclosed within square
brackets. The menu bar, located directly below the title bar, provides pull-down menus
from which you can choose commands. You can also activate commands by clicking
the buttons on the various toolbars. The status bar along the bottom of the screen shows
the coordinates of the screen cursor as well as the current setting of various AutoCAD
program modes. You’ll learn more about the status bar later in the chapter.
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Figure 1-1. The typical layout of the AutoCAD screen
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By default, AutoCAD now displays the full drawing filename, including the drive and
full path, in the title bar. This option is controlled in the File Open area of the Open and
Save tab of the Options dialog box.

The command window is one component of AutoCAD that does not have an
equivalent in most other Windows programs. You can start any AutoCAD command
by typing the command and then pressing ENTER. Some of the components always
appear in the same location. Others, such as the toolbars and command window, can
be turned off or relocated anywhere on your Windows desktop. Figure 1-2 shows an
AutoCAD screen in which some of these components have been rearranged.

The document window, or drawing area, occupies most of the screen. This is the area
in which you actually create your drawing. (Remember that you can have more than
one drawing open at a time. Each has its own document window.) Notice that there are
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Figure 1-2. The AutoCAD screen after rearranging several of the components
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two other elements within this window: an icon with two arrows pointing at 90-degree
angles, and an icon that looks like a small plus sign (+) with a box at its center. These
are the User Coordinate System (UCS) icon and the drawing cursor, respectively.

UCS Icon
The UCS icon helps you understand how your drawing is oriented. The icon consists of
two arrows, one pointing to the right and one pointing to the top of the drawing area.

Notice that one arrow is labeled X and the other Y. These labels indicate the current
orientation of the drawing’s X and Y axes. Notice, too, the inclusion of a square
where the two arrows intersect. This indicates that the UCS corresponds to the World
Coordinate System (WCS). You will learn more about coordinates and coordinate
systems in Chapter 6.

The UCS icon looks considerably different than it did in earlier versions of AutoCAD.
Although the new icon is much more intuitive, you can change the appearance of the
icon to that used in earlier versions, as described in Chapter 6.

Crosshairs, Pickbox, and Cursor
Notice that the drawing cursor moves around the screen as you move the mouse. You
use the cursor for selecting points or objects within the drawing area. The appearance
of the cursor changes depending on which AutoCAD command is currently active or
where you move the cursor within the AutoCAD screen.

By default, the cursor appears as a small plus sign with a box at its center. The point
at which the crosshairs meet is the actual cursor position and corresponds to a specific
point within the AutoCAD drawing. The box, called a pickbox, is used to select objects
within the drawing.

When you activate an AutoCAD command used to create a new object, such as
the LINE command (used to draw lines), the pickbox disappears, leaving just the

Crosshairs

Pickbox
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crosshairs. Move the cursor to a start position in the drawing area and click to select
that point. Then, move the cursor to a different position corresponding to the end point
of the line and click again to select the end point of the line. The line is drawn.

Throughout this book, the term click is used to mean pressing the left-mouse button
(or the pick button on a multibutton digitizer puck) one time. Double-click means to
click the left-mouse button twice in quick succession. Right-click means to click the
right-mouse button (or button two on a multibutton puck), and SHIFT-right-click means
that you should press the SHIFT key while simultaneously clicking the right-mouse
button. Drag means that you should press and hold down the left-mouse button while
moving the mouse.

If you activate a command to modify an existing object, such as the ERASE
command, the crosshairs disappear, leaving just the pickbox. You can then select the
object to be erased by moving the cursor so that the pickbox is over the object, and
clicking to select the object.

To ensure accuracy when selecting points with the drawing cursor, you can use
AutoCAD’s object snap modes to snap the crosshairs to a specific point on an existing
object, such as the end point of a line or the center of a circle. When an object snap
mode is active, the cursor appears with both the crosshairs and a slightly different
pickbox, called an aperture box. When prompted to select a point, move the cursor so
that the aperture box falls over a line. As you click the cursor, it automatically snaps
to the end point of the line.

If you move the cursor outside the drawing area, the cursor changes to one of
several standard Windows pointers. For example, when moving the cursor over a
toolbar or the status bar, the cursor changes to a Windows arrow. You can then select
a command by clicking the toolbar button or menu command.

Status Bar
The status bar at the bottom of the AutoCAD screen displays both the current cursor
position and the status of various AutoCAD modes (see Figure 1-3). The cursor position
displays as either X, Y, Z coordinates or, when certain drawing commands are active,
as a distance and angle relative to the last point selected. As you move the cursor, the
coordinates update automatically. You can toggle the automatic coordinate display on
and off by clicking within the coordinate display area, or by pressing the F6 function key.

The other option buttons on the status bar indicate the current Snap mode, grid
display, Ortho mode, polar tracking, object snap, and object snap tracking settings,
whether lineweights are visible, and the current drawing space (model space or paper
space). You can toggle these modes on and off by clicking the appropriate button.
You’ll learn more about these modes in Chapter 2.

When you move the cursor over a toolbar or menu command, the status bar
changes to display information about the selected command (see Figure 1-4).
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Figure 1-3. The components of the status bar
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Figure 1-4. The status bar showing information about the current command
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If you look carefully at the command description on the status bar, you’ll see a single
word to the right of the colon at the end of the description. This is the actual AutoCAD
command. You can activate the command by typing this command name at the
AutoCAD command prompt, described later in this chapter. The names used for
commands in the menus may be different from the actual command names.

Pull-Down Menus
Most AutoCAD commands, as well as numerous standard Windows functions, are
available from pull-down menus on the menu bar. These menus are arranged in a
hierarchical fashion. For example, all commands for opening, saving, and printing
drawings (which are standard Windows functions) are available in the File pull-down
menu. Commands for drawing new AutoCAD objects are found in the Draw
pull-down menu.

Figure 1-5 shows a typical pull-down menu. Notice that some menu items display
a small black arrow to the right of the command name. Clicking such a command or
item expands the menu to display a cascading submenu containing additional options
to the command or a collection of related commands. Other menu items have an
ellipsis (three dots) immediately following the command name. This indicates that by
selecting the command, a dialog box will be displayed.

Pull-down menus often contain other components. An underlined letter on a menu
corresponds to the access key, which you can type from the keyboard to start the
command. To display a pull-down menu, press the ALT key in combination with the
access key that is shown for the menu name. Shortcut keys indicate a keyboard key or
a key combination that invokes a particular command without requiring the use of a
menu, such as F2 to display AutoCAD’s Text window, or CTRL-C to copy objects to the
Windows Clipboard. Although you might not use access keys and shortcut keys at
first, as you become more familiar with AutoCAD, you will likely use these faster
alternatives for starting AutoCAD commands.

Notice that the pull-down menu also contains separators, lines that help divide the
commands into logical groups of related commands. For example, the Zoom, Pan, and
Aerial View commands all can be used to change the way the drawing is displayed,
and thus are grouped together. Although not shown in Figure 1-5, sometimes a
command cannot be used. For example, the REDO command can be used only
immediately after using the UNDO command. When a command is unavailable, it
appears dimmed or grayed. Also, notice that in the UCS Icon submenu, the On and
Origin selections appear with a check mark. A command or option preceded by a check
mark indicates that the command or option can be turned on or off.
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Shortcut Menus
The shortcut menus are special menus that display at the cursor position when you
press the right-mouse button. Shortcut menus are completely context-sensitive. The
functions displayed in the menu vary depending on the location of the cursor when
you right-click, the type of object selected, and whether an AutoCAD command is
active. If you press the SHIFT key and right-click at the same time, AutoCAD displays
the Object Snap shortcut menu.

Figure 1-5. A typical pull-down menu, expanded to show the UCS Icon submenu

Command separator

Checked command (indicates
that the option is selected)

Submenu

Menu name

Access key (underlined letter)

Shortcut key

Click to display dialog box

Click to display submenu
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If you are using an IntelliMouse or a three-button mouse, pressing the middle button
either displays the Object Snap shortcut menu or activates real-time panning, depending
on the current value of the MBUTTONPAN system variable.

Toolbars
When you start AutoCAD for the first time, the Standard, Object Properties, Draw, and
Modify toolbars are displayed. AutoCAD’s standard menu provides 26 toolbars, each
of which contains a group of related commands. You can have any of these toolbars
visible at any time and control where they are placed on the desktop. All of these
toolbars can be customized by adding and deleting buttons. You can also move and
resize the toolbars, and create new toolbars. Toolbars are probably the easiest and
fastest way to start AutoCAD commands. As you become more proficient, you will
probably want to modify the default toolbars or create your own so that the commands
you use most often are always conveniently available.

Since you want the most frequently used commands readily available, it makes
sense that two toolbars in particular appear by default across the top of the AutoCAD
window. The Standard toolbar contains buttons for standard Windows functions, such
as opening, saving, and printing files, cutting-and-pasting objects to and from the
Windows Clipboard, and undoing or redoing your previous actions. It also contains
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many standard AutoCAD functions, such as panning and zooming the display of the
drawing area. The Object Properties toolbar, as its name implies, contains buttons and
drop-down list boxes for controlling the properties of AutoCAD objects, such as the
current layer, color, and linetype. These toolbars are shown in Figure 1-6.

The TOOLBAR command displays the Toolbars tab of the Customize dialog box,
where you choose which toolbars are displayed (see Figure 1-7). To display a toolbar,
click the box adjacent to its name so that an X appears in the box. To close a toolbar, click
the box adjacent to its name so that the X disappears. You can also set other options, such
as whether toolbars are displayed with large or small buttons, and whether to display or
hide ToolTips. When ToolTips are enabled, a brief description of the command appears
as you momentarily pause the arrow cursor over a toolbar button.

ToolTips make it easier to learn the purpose of each toolbar button until you have
memorized what each icon represents. The Customize dialog box also contains the
tools you use to customize toolbars.
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Figure 1-6. The Standard toolbar and Object Properties toolbar
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You can also simply right-click while the arrow cursor is over any toolbar to
display the Toolbars shortcut menu containing a list of all the toolbars (see Figure 1-7).
You can then toggle selected toolbars on and off by clicking their name in the menu. A
check mark indicates that the toolbar is currently visible. Clicking Customize displays
the Toolbars tab of the Customize dialog box.

Toolbars are either docked (attached to any of the edges of the drawing area) or
floating (freestanding elements anywhere on the desktop). When you start AutoCAD
for the first time, the displayed toolbars are all docked. A floating toolbar has a Title
bar and a Close box, and can be resized. Here are some techniques for controlling the
display and placement of toolbars:

■ To undock (or float) a toolbar, click anywhere inside the toolbar, except on a
button, and drag the toolbar away from the perimeter of the drawing area.

■ To dock a toolbar, drag it to the perimeter of the drawing area (also called the
docking area).
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Figure 1-7. You control which toolbars are visible by using (from left to right) the
Toolbars tab of the Customize dialog box or the Toolbars shortcut menu.
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■ To position a toolbar in a docking area without docking it, press CTRL while you
drag it.

■ To move a toolbar, drag it to a new location.

■ To resize a toolbar, move your cursor to the edge of the toolbar until it changes
to a resize arrow, and then drag.

■ To close a toolbar, right-click to display the Toolbars shortcut menu, and then
click the toolbar name within that menu to remove the check mark. You can
also close a toolbar by floating it and then clicking the Close button in the
upper-right corner of the toolbar, or by using the Toolbars dialog box.

Some buttons, such as the Zoom Window button on the Standard toolbar, contain
flyouts. Flyouts either provide options for using the command with different methods
or contain other, related commands (see Figure 1-8). Flyouts are indicated by a small
triangle in the lower-right corner of the button. To display a flyout, click the toolbar
button and hold down the mouse button. To select a button from a flyout, continue to
hold down the mouse button while pointing to the button you want, and then release
the mouse button. In addition to starting the command you specified, the button you
selected on the flyout becomes the default button on the toolbar.

Figure 1-8. Flyouts extend from some toolbar buttons.
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Model Tab and Layout Tabs
If you’ve used previous versions of AutoCAD, you’ll notice something new at the
bottom of the drawing area, between the document window and the command
window. The Model tab and Layout tabs (see Figure 1-9) enable you to switch your
drawing between model space and paper space. You generally create your drawings in
model space, and then switch to paper space to create layouts and print your drawing.

In AutoCAD R14 and earlier, AutoCAD used a single model space and a single
paper space. Beginning with AutoCAD 2000, model space has become much more
visual, showing you exactly what your drawing will look like when printed. Paper
space is also much more flexible than in the past. You can now create multiple
paper space layouts from the same drawing. This enables you to consolidate multiple
drawing sheets into a single drawing file. For example, you can create individual
layouts for the floor plan, electrical plan, and plumbing plan of a building from a single
drawing file, without having to constantly turn layers on and off. Buttons to the left of
the Model and Layout tabs enable you to scroll through these tabs when your drawing
has more tabs than will display across the screen. You’ll learn about creating paper
space layouts in Chapter 17.

Figure 1-9. The Model tab and Layout tabs switch between model space and
paper space.

Buttons for scrolling through multiple
paper space Layout tabs

Model space tab

Paper space Layout tabs
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Command Window
The Command window is where you type AutoCAD commands and view prompts
and messages. When initially displayed, the Command window is docked at the
bottom of the screen, between the drawing area and the status bar. The Command
window initially displays the three most recent lines of prompts, but you can change
the number of lines displayed. Scroll bars on the right side of this window let you
scroll back to see previous prompts. You can undock and move this window by
dragging it, and also dock it at the top of the drawing area.

The Command window can be resized to change the number of lines of text it
displays, by dragging the split bar, which divides the Command window from
the drawing area (see Figure 1-10). When the Command window is floating, you
can also resize its width. When docked, it always extends across the width of the
AutoCAD window.
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Figure 1-10. Resize the docked Command window by dragging the split bar.
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You can also change the number of lines of text displayed in the docked Command
window from the Display tab of the Options dialog box.

Text Window
In addition to the AutoCAD drawing environment (sometimes called the Graphics
window) described thus far, the Text window is another important element to the
interface. The Text window is a second window in which you can type AutoCAD
commands and view prompts and messages (see Figure 1-11). Initially, the Text
window is not visible, although it becomes visible when you use certain AutoCAD
commands. For example, the LIST command automatically activates the Text window.
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The Options Dialog Box
Throughout this chapter and in other areas throughout this book, you will find
references to the Options dialog box. This dialog box contains controls for
customizing many of AutoCAD’s settings. A detailed description of this dialog
box can be found in Appendix C.

The Options dialog box contains nine separate pages, or tabs, each controlling
a different aspect of AutoCAD:

■ Files Specifies the directories that AutoCAD searches to find special
files, such as menus, drivers, and support files. It also specifies optional
user-defined settings, such as the dictionary used for spell checking.

■ Display Contains controls for customizing AutoCAD’s display, such as
screen colors and the number of lines in the Command window.

■ Open and Save Controls how often AutoCAD automatically saves your
drawings and whether it creates a backup copy.

■ Plotting Controls options related to plotting, such as the default plot
settings for new drawings.

■ System Controls general AutoCAD system settings, such as the current
graphics and pointing device drivers and whether you can open multiple
drawings.

■ User Preferences Contains controls that let you optimize the way you
work with AutoCAD, such as the default drawing units and the use of
accelerator keys and shortcut menus.

■ Drafting Enables you to control various editing options, such as the use
of AutoSnap and Auto Tracking.

■ Selection Controls AutoCAD’s selection modes and the use of grips.

■ Profiles Allows you to create user-defined configurations.
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Unlike the Command window, the Text window cannot be docked. It always appears
in its own window and, when activated, has its own task button on the Windows taskbar.
The Text window contains many more lines of prompts, along with its own scroll bars.
This window can be resized, minimized, or closed entirely when not needed, without
affecting the main AutoCAD window.

To switch between the main AutoCAD drawing window and the Text window, press F2.
If the Text window is not active, pressing F2 activates and immediately displays the Text
window. Pressing F2 subsequently toggles back and forth between the Graphics window
and the Text window.

You can cut-and-paste text between the Text window and the Windows Clipboard.
Most standard Windows CTRL key combinations and cursor keys can also be used in
the Text window.
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Figure 1-11. The Text window
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Screen Menu
Although it does not initially appear, AutoCAD has an additional screen component
that you can display and use for starting commands. The screen menu (sometimes called
the side menu) consists of an area on the right edge of the drawing area. When you
move the cursor over a menu item, the item becomes highlighted. You then click to
select a menu item. Clicking an item shown in all uppercase letters switches the menu
to display a related selection of commands. Clicking an item shown in mixed uppercase
and lowercase letters starts that command. You turn the screen menu on or off from the
Display tab of the Options dialog box. The screen menu behaves like a toolbar. Once
displayed, you can undock it and reposition it as you would any toolbar.

The screen menu is similar to menu systems used by older CAD systems. In earlier
versions of AutoCAD, the screen menu was the primary method of starting commands,
other than typing them at AutoCAD’s command prompt. Because the screen menu is
always visible when it is active, it consumes a considerable portion of the drawing area.
For that reason, most users choose not to display this screen component.

Digitizer Template
While not part of the AutoCAD screen, the digitizer template represents an additional
interface that you can use when working with AutoCAD. A digitizer is a large, flat pad
with an associated pen or puck. The puck may look similar to a mouse, but often has
many more buttons. Digitizers vary in size from a few inches square to tablets
measuring 48 inches by 60 inches or more.

As you move the puck, wires below the surface of the digitizer track the puck’s
movement. AutoCAD’s cursor follows these movements. Thus, as a pointing device,
a digitizer or tablet is somewhat similar to a mouse, but there are a few significant
differences. A mouse is a relative pointing device, meaning that the position of the cursor
onscreen is only relative to its previous position. If you roll the mouse to the edge of
your mouse pad, you can lift it up and reposition it without changing the position of
the cursor. With a digitizer, the position of the puck is directly related to the position
of the cursor. Thus, a digitizer is an absolute pointing device. You can accurately trace
paper drawings by using a digitizer, which is something you can’t do with a mouse.
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Digitizers provide another capability in AutoCAD in addition to tracing paper
drawings. AutoCAD comes with a sample drawing called Tablet 2000.dwg. You can
plot a copy of this drawing and attach it to your digitizer. This digitizer template
includes a screen pointing area and numerous rectangular areas filled with icons. The
standard AutoCAD menu maps AutoCAD commands to specific areas of the template.
Once properly configured, you can start a command by moving the puck over the
specific area and clicking. Refer to Appendix C for additional information about
configuring a digitizer template.

Although the trend today seems increasingly to be toward the use of toolbars rather than
digitizer template menus to select commands, digitizers are still an essential tool for
accurate tracing.

Selecting Commands
Now that you’ve learned about the AutoCAD interface, you have a better understanding
of the many ways in which you can select commands. You can select AutoCAD
commands by using any of these methods:

■ Click a button in a toolbar.

■ Choose a command from a pull-down menu.

■ Type the command in the Command window or Text window.

■ Choose a command from a shortcut menu.

■ Click a command on the screen menu.

■ Click a command on the digitizer template.

Some commands remain active until you end them, so that you can repeat an action
without having to select a command repeatedly. You can end such a command by
pressing ENTER or ESC, or by right-clicking and choosing Enter or Cancel from the
shortcut menu.

The discussions that follow do not discuss command selection from the screen menu or
digitizer template, since these methods are used less often. Feel free to experiment with
using all six methods for selecting commands, and use whichever ones you find most
comfortable or efficient.

Starting Commands from Menus
To start a command from a menu, choose it from the list of available menu options.
You can also use the ALT key in combination with the appropriate access key to open
a specific pull-down menu and then press the access key for the desired command.
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To use a command on a menu to draw a line:

1. Move the cursor to the menu bar and choose the Drawing menu by clicking
Draw. The menu displays the various drawing commands.

2. Click Line. The menu disappears and AutoCAD displays the prompt:

Specify first point:

in the Command window, asking you to select the starting point of the line.

3. Move the cursor within the drawing area and then click to select the line’s
starting point. AutoCAD now prompts:

Specify next point or [Undo]:

asking you to select the end point of the line.

4. Move the cursor again and then click to select the end point of the line. Again,
AutoCAD prompts you to select an end point.

5. Move the cursor and click to select another point.

6. Right-click to display the shortcut menu, and then choose Enter to end
the command.

To close a pull-down menu without choosing a command, press ESC. You can also click
anywhere in the drawing area or choose another pull-down menu item.

Starting Commands from Toolbars
To start a command from a toolbar, click a button and then respond to the prompts that
appear in the Command window.

To use a button from a toolbar to draw a circle:

1. From the Draw toolbar, click the Circle button. In the Command window,
AutoCAD displays the prompt:

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:

This prompt displays several options of the CIRCLE command. The default
option is to select the center point of the circle.

2. Move the cursor within the drawing area and then click to select the circle’s
center point. AutoCAD now prompts:

Specify radius of circle or [Diameter]:

Again, AutoCAD displays several options. The default option is to specify the
radius of the circle.

3. Notice that as you move the cursor, you can change the size of the circle by
dragging a radius line from the circle’s center point. To complete the circle,
select a point or type a value for the radius and then press ENTER.
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Starting Commands from the Command Line
To start a command from the command line, type the command and then press ENTER.

As you already saw, when an AutoCAD command has several options, these
options are displayed on the command line. The default option is displayed as part of
the command prompt, and the other options are enclosed within square brackets and
separated by forward slash characters.

You don’t need to type anything to select the default option. For example, when
you drew the circle in the previous example, you simply selected the center point when
AutoCAD displayed it as the default option. Similarly, to specify the radius of the
circle, you simply selected a point on the radius of the circle or typed the radius value.

If you want to specify the size of the circle by using its diameter, however, you
select the diameter option. To select a different option, type the letter or letters (shown
capitalized) to select the option and press ENTER. For example, to specify the diameter
of the circle, type D and press ENTER. AutoCAD then prompts you to specify the
diameter of the circle. You can also select the command option from the shortcut menu
that is displayed by right-clicking. You’ll learn more about the shortcut menus in the
next section.

All AutoCAD commands can be started by typing the complete command name. Some
commands also have abbreviated names, called aliases. You can start these commands by
typing the command alias. For example, you can start the LINE command by typing L
and pressing ENTER. In the chapters that follow, whenever an alias is available, the
instructions for starting a command by typing show the command aliases along with the
command name. Command aliases are defined in the ACAD.PGP file. You’ll learn more
about this file in Chapter 28.

Using Shortcut Menus
When you right-click the mouse, AutoCAD displays a shortcut menu from which you
can choose various options. The shortcut menu is context-sensitive, which means that
the options presented in the menu vary depending on the cursor position when you
right-click, any objects already selected, and the current status of AutoCAD, such as
whether a command is already active.

Right-clicking in the drawing area displays one of the following six shortcut menus.
The menu that displays depends on AutoCAD’s current status, and whether you
right-click a blank area or an object within the drawing.

■ Default Displayed when no command is active and no objects are selected.
This menu contains common options, such as Copy, Paste, Pan, and Zoom.

■ Edit Displayed when no command is active, by right-clicking when a drawing
object is selected. This menu contains editing commands specific to the type
of object selected.
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■ Command Displayed when a command is active. This menu contains the
command options, as well as other commands, such as Pan and Zoom.

■ Object Snap Displayed by pressing SHIFT or CTRL while you right-click. This
menu contains all the object snaps, object snap settings, and point filters. You’ll
learn about object snaps in Chapter 2.

■ Hot Grips Displayed by right-clicking a hot grip. This menu contains grip
editing commands. You’ll learn about grips in Chapter 7.

■ OLE Displayed by right-clicking an OLE object. This menu contains options
for editing OLE objects. You’ll learn about OLE objects in Chapter 24.

■ Hyperlinks Displayed by right-clicking when a graphical object with an
attached hyperlink is selected. This menu contains options for opening,
copying, and editing the hyperlink, as well as for adding it to your Favorites
list. You’ll learn more about hyperlinks in Chapter 25.

In R14 and earlier versions of AutoCAD, instead of displaying a shortcut menu,
right-clicking was equivalent to pressing ENTER. Since some users may wish to retain
that behavior, AutoCAD provides several settings that control the use of shortcut
menus. The Object Snap, Hot Grips, and OLE shortcut menus are always available.
Within the User Preferences tab of the Options dialog box, however, you can individually
control whether AutoCAD displays the Default, Edit, Command, and Hyperlink
shortcut menus or behaves as it did in these previous versions. In addition to turning
these menus on and off, you can customize the options displayed in the menus as you
would customize any other aspect of AutoCAD’s menus. You’ll learn about customizing
AutoCAD’s menus in Chapter 28.
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In addition to clicking in the drawing area, you can right-click other AutoCAD
window areas to display one of the following additional shortcut menus. Again, the
menu that displays depends on where you click.

■ Toolbar Right-clicking any portion of any toolbar displays a shortcut menu
you can use to display, hide, or customize any available toolbar.

■ Command line Right-clicking the command line or text window accesses the
six most recently used commands, as well as the Copy and Paste commands.

■ Dialog box or window Right-clicking within any dialog box or window
displays a shortcut menu containing options appropriate to the particular
function.

■ Status bar Right-clicking the coordinate display or any of the buttons on
the status bar displays a shortcut menu for controlling the selected setting.

■ Model/Layout Right-clicking the Model tab or any of the Layout tabs displays
a shortcut menu containing the plotting, page setup, and layout setup
commands. You’ll learn more about these functions in Chapters 17 and 18.

Using Pointing Devices
In addition to using your mouse or digitizer to select commands and points within
the drawing, you can use the other buttons on the pointing device to activate other
AutoCAD functions. For example, as you’ve just learned, you can right-click to display
shortcut menus. If you are using a three-button mouse, the middle button either
activates real-time panning or displays the Object Snap shortcut menu, depending on
how AutoCAD is currently configured.

If you are using an IntelliMouse, the small wheel between the left and right buttons
provides the following additional functions:

■ Rotate the wheel forward to zoom in or rotate it backward to zoom out. By
default, each increment changes the zoom factor by 10 percent, but you can
change this increment by changing the ZOOMFACTOR system variable.

■ Double-click the wheel to zoom to the drawing extents.

■ Press the wheel and drag the mouse to pan the drawing.

You’ll learn about panning and zooming to move around within a drawing in
Chapter 5.

Repeating a Command
You can repeat the command you just used, without having to reselect it, by pressing
either the SPACEBAR or ENTER, or by right-clicking and choosing the Repeat command
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item at the top of the shortcut menu, where command represents the name of the most
recently used command.

When entering commands from the command line, you can type MULTIPLE
before starting some commands (such as CIRCLE or ARC) to repeat a command
indefinitely. When you are done with the command, press ESC.

You can repeat any command you have used during the current AutoCAD session by
using the UP ARROW and DOWN ARROW keys to navigate to a previous command. When
the command name is displayed on the command line, press ENTER. You can also locate a
previously used command in the command history (in the Text window), cut the command
to the Windows Clipboard, and paste it to the command line. Remember that you can also
right-click in the command window to access the six most recently used commands.

Using Commands Transparently
Certain commands can be used while another command is active. For example, while
drawing a line, you may want to use the PAN command to move the drawing across
the screen to select the end point of the line. You can also change the settings of drawing
aids, such as snap or grid, while other commands are active. Commands that can be
used while another command is active are called transparent commands.

When you start a command from a toolbar or menu and another command is
already active, AutoCAD automatically starts the new command transparently, if
possible. If the command can’t be used transparently, the active command is canceled
and the new command is started.

To use a command transparently from the command line, type an apostrophe (‘)
before the name of the command. AutoCAD displays double angle brackets preceding
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the prompt on the command line to indicate when a command is being used
transparently. For example, to change the snap spacing to ten units while you are
drawing a line, enter the following:

Command: LINE

Specify first point: ' SNAP

>>Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] <0.5000>: 10

Resuming LINE command.

Specify first point:

Most commands that do not select objects, create new objects, or cause the drawing to be
regenerated can be used transparently. Changes made by using dialog boxes that have been
opened transparently do not take effect until the original command has been completed.

Correcting Mistakes
AutoCAD keeps track of all the commands you use and the changes you make. If you
change your mind or make a mistake, you can undo, or reverse, the last action or
several previous actions. You can also redo the last action that you reversed.

The Undo and Redo buttons on the Standard toolbar provide the easiest means to
undo or redo the previous action.

To undo the most recent action, use one of the following methods:

■ On the Standard toolbar, click Undo.

■ From the Edit menu, choose Undo.

■ At the command line, type U and then press ENTER.

■ Press the CTRL-Z shortcut key combination.

■ Right-click to display the shortcut menu, and then choose Undo.

You can also use the UNDO command to reverse several actions at once. To undo a
specific number of actions:

1. At the command prompt, type UNDO.

2. On the command line, enter the number of actions to undo, and then press
ENTER. For example, to reverse the last five actions, type 5.

RedoUndo
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The UNDO command provides other options that let you mark actions as you work.
You can then restore the drawing to its condition at that point by undoing back to a
previously established mark. You can also use the Begin and End options of the UNDO
command to group several actions and later reverse the actions of the entire group.

If you erase one or more objects by mistake, you can use the OOPS command to restore
them to the drawing.

To redo an action, do one of the following:

■ On the Standard toolbar, click Redo.

■ From the Edit menu, choose Redo.

■ At the command line, type REDO and then press ENTER.

■ Press the CTRL-Y shortcut key combination.

■ Right-click to display the shortcut menu, and then choose Redo.

The REDO command reverses the action of the last U or UNDO command. To redo
something, you must use the REDO command immediately after using the U or
UNDO command.

Getting Online Help
AutoCAD includes an online Help system containing all the printed documentation
that comes with AutoCAD as well as various additional documents supplied only in
electronic form. You can get help about any AutoCAD command or topic by using the
online Help system.

To display AutoCAD’s online Help system, do one of the following:

■ On the Standard toolbar, click the Help button.

■ From the Help menu, choose AutoCAD Help.

■ At the command line, type HELP and then press ENTER.

■ Press the F1 key.

The first time you access the Help system when no command is active, AutoCAD
displays the AutoCAD Help Contents tab (see Figure 1-12). Once you have used Help,
the last tab you used is recalled the next time you bring up Help. When a command
is active, accessing the Help system displays information about that command. For
example, if you start the LINE command and then access the Help system by using any
of the methods just listed, the program displays information about the LINE command
(see Figure 1-13).
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AutoCAD also includes an Active Assistance window. The contents of this window
change dynamically as you work, displaying information about the current command
or dialog box. You can manually hide or show this window and also control how and
when the Active Assistance window is automatically opened. For example, you may
only want to display the window when you’re working in a dialog box, or to only
display information when you use a new command for the first time.

Figure 1-12. The AutoCAD online Help Contents tab
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To display the Active Assistance window, do one of the following:

■ On the Standard toolbar, click the Active Assistance button.

■ From the Help menu, choose Active Assistance.

■ At the command line, type ASSIST and then press ENTER.

You can also control the type of information displayed in the Active Assistance
window. For example, you can configure the window to display general information
about a dialog box, or specific information about the dialog box option beneath the
arrow cursor. To change any of the Active Assistance settings, right-click in the Active
Assistance window and then select Settings from the shortcut menu to display the
Active Assistance Settings dialog box (see Figure 1-14).

If you change the Activation setting to On Demand, Active Assistance remains active
even when it is not visible, and you may hear a clicking sound when moving the cursor
within a dialog box. To disable Active Assistance so that it no longer monitors your
actions, right-click the Active Assistance icon located in your system tray in the bottom
right-hand corner of your display to display the shortcut menu, and then choose Exit.
To reactivate Active Assistance, simply display the Active Assistance window again.

Figure 1-13. Accessing Help while a command is active displays information about
that command.
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In addition to AutoCAD’s Help system, the Help pull-down menu provides a link
to the Product Support page on Autodesk’s Point A web site. There you will find links
to technical support, a knowledge base of Autodesk technical support information,
copies of the latest patches and software updates, discussion groups, and other on-line
resources. The Help menu also provides links to the Autodesk Users Group
International web site and the Autodesk Learning Assistance.

AutoCAD comes with a Learning Assistance CD that provides interactive lessons to
help you learn how to use AutoCAD. In order to access Learning Assistance from within
AutoCAD, you must first install the Learning Assistance software by running the
Setup program on the Learning Assistance CD. If you prefer to run this software from
the CD rather than installing it onto your system, run the Setup program and choose
Run rather than Install. You’ll be able to access all of the lessons, but Learning
Assistance will not be accessible from the Help menu.

Complete Reference / AutoCAD: TCR / Cohn / 222429-0 / Chapter 1

Figure 1-14. The Active Assistance Settings dialog box

Select to display information specific to
the dialog box option beneath the cursor

Select to load Active Assistance
when AutoCAD starts

Select to open every time any
command is activated

Select to open only when a new
command is activated

Select to open for
dialog boxes only

Select to disable Active Assistance except
when specifically opened by the user
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Opening Existing Drawings
Now that you’re more familiar with the AutoCAD environment, you are ready to learn
how to open an existing drawing. Since it often takes several days to complete a detailed
drawing, you will probably open existing drawings more often than you create new
ones. In the next chapter, you’ll learn how to create new drawings.

To open an existing drawing, use one of the following methods:

■ On the Standard toolbar, click the Open button.

■ From the File menu, choose Open.

■ At the command line, type OPEN and then press ENTER.

■ Press the CTRL-O shortcut key combination.

AutoCAD remembers the names of the most recent drawings that you worked on. To
quickly open a drawing file that you recently used, choose its name from the list in the
lower portion of the File pull-down menu.

AutoCAD displays the Select File dialog box. You can preview the drawing by
clicking it to highlight the filename in the list of files (see Figure 1-15). To open a
drawing, either double-click the filename in the list of files or highlight the file and
then click Open. You can also type its name (or a partial name and wildcards) in the
File Name edit box and then click Open.

The icons on the left side of the dialog box provide quick access to commonly used files
and file locations. Click any one of these icons to display the files at that location. You
can reorder these icons by dragging them to a new location in the list. To add or modify
an icon, right-click the icon to display a shortcut menu. You cannot remove the Point A,
Buzzsaw, or Red Spark icons.

AutoCAD can also help you find drawings and other AutoCAD files located in
other folders on your hard drive. You can instruct AutoCAD to search in one or more
directories and on one or more drives, even across a local area network.

To use the file search utility, click Tools | Find in the Select File dialog box.
AutoCAD displays the Find dialog box (see Figure 1-16). Notice that the dialog box has
two tabs. The Name & Location tab provides tools to help filter your search based on
the file type, filename, and location. The Date Modified tab lets you filter your search
based on the date the file was created or modified. For example, you can search for all
drawing files on the C drive that were created after a specific date. To start the actual
search, click Find Now. After several seconds, AutoCAD displays a list of all the
drawing files that match your search criteria. To open a drawing, select it in the list,
click OK, and then click Open in the Select File dialog box.
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You can also open an existing drawing using the AutoCAD 2002 Today window
(see Figure 1-17). To open the AutoCAD 2002 Today window (if it is not already open),
do one of the following:

■ On the Standard toolbar, click the Today button.
■ From the Tools menu, choose Today.
■ At the command line, type TODAY and then press ENTER.
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Figure 1-15. The Select File dialog box
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file search utility

Select the folder in which
the drawing is located

Click to partially
open the drawing
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The upper portion of this window includes an area called My Workplace.
On the left side of this area is an area called My Drawings, which contains three
tabs. If you select the Open Drawings tab, AutoCAD displays a list of recently
opened drawings. By default, this list is sorted by date. You can also sort the list
alphabetically by filename or by location (drive letter and folder name). When
you move the cursor over a drawing name, AutoCAD displays a preview image
of the drawing. If you pause the cursor over a drawing name, AutoCAD displays
its complete path and the date and time it was last opened. To open a drawing,
simply click the drawing name.

Figure 1-16. The Find dialog box

Names of files found

Specify the file type. Click to limit the search to files saved
before or after a specific date and time

Limit the search to specific
drives or subfolders
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Working with Multiple Drawings
You can open more than one drawing in a single AutoCAD session. Each open
drawing appears within its own document window with the drawing name displayed
in the title bar of each window. Although you may have multiple drawings open at
once, only one drawing is active (or current) at a time. AutoCAD commands only affect
the active drawing.

When multiple drawings are open, you can simply click anywhere in a drawing’s
document window to make it the active drawing. You can also press CTRL-F6 or
CTRL-TAB to switch between open drawings, or select the active drawing from the
Window pull-down menu. Individual document windows can be moved, resized,
minimized, and maximized just like any other Windows document window, and you
can use the other commands on the Windows pull-down menu to tile or cascade all of
the open drawings.

Having multiple drawings open simultaneously also offers the ability to
copy-and-paste objects, settings, and properties between drawings.
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Figure 1-17. The AutoCAD 2002 Today window
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Using Partial Open and Partial Load
You can use the Partial Open option to open just a portion of a drawing file, thus
improving AutoCAD’s performance when working with a large drawing file. When
you use the Partial Open option to open a drawing, you load only the geometry
contained within a previously saved view and on specific layers. For example, if you
load geometry from the WEST-WING view and the WALLS layer, AutoCAD loads
into the drawing everything from the WALLS layer that falls within the WEST-WING
view. Once loaded, you can edit only the geometry that has been loaded, but you can
subsequently use the PARTIALOAD command to load additional geometry from
another view or on other layers.

To partially open a drawing, follow these steps:

1. Do one of the following:

■ On the Standard toolbar, click the Open button.

■ From the File menu, choose Open.

■ At the command line, type OPEN and then press ENTER.

■ Press the CTRL-O shortcut key combination.

2. In the Select File dialog box, select the drawing you want to open, and then click
the arrow next to the Open button (see Figure 1-15) and choose Partial Open from
the drop-down list to display the Partial Open dialog box (see Figure 1-18).

3. In the Partial Open dialog box, under View Geometry To Load, select the name of
the view you want to load. The default view *Extents* loads the entire drawing.

4. Under Layer Geometry To Load, select one or more layers.

5. Click Open.

If you don’t select any layers to load, no geometry will be visible, but all layers still exist
in the drawing. If you draw on a layer whose geometry has not been loaded, you may be
drawing on top of existing geometry that isn’t loaded.

When a drawing has been partially loaded, you can edit only the geometry that has
been loaded. If necessary, you can load additional geometry using the Partial Load
dialog box. This dialog box is almost identical to the Partial Open dialog box, except
that in addition to specifying a previously named view, you can click the Pick A
Window button and then specify an area within the drawing in which to load the
additional geometry. To load additional geometry into a partially open drawing,
follow these steps:

1. Do one of the following:

■ From the File menu, choose Partial Load.

■ At the command line, type PARTIALOAD and then press ENTER.
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2. In the Partial Load dialog box, select the view name or click the Pick A Window
button to define a rectangular view area.

3. Select one or more layers whose geometry you want to load.

4. Click OK.

The PARTIALOAD command is available only if the current drawing is a partially
open drawing. When a drawing is partially open, the designation “(Partially loaded)”
appears on the title bar of its document window, adjacent to the drawing name.

Figure 1-18. The Partial Open dialog box
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Saving Your Work
As you work, you should save your drawing periodically. This ensures that you don’t
accidentally lose important work in the event of a power failure or other mishap. When
you first start a new drawing, the file has no name. Thus, the first time you save it,
AutoCAD displays a dialog box and prompts you to name the file. Once the file has
been saved, or if you open an existing drawing, the SAVE command saves the drawing
immediately, without bringing up a dialog box, and includes any changes you may
have made to the current file. If you want to save a copy of the drawing without saving
changes to the original file, you can use the SAVEAS command to save the drawing
under another name.

To save a drawing, do one of the following:

■ On the Standard toolbar, click the Save button.

■ From the File menu, choose Save.

■ At the command line, type SAVE and then press ENTER.

■ Press the CTRL-S shortcut key combination.

When you save a drawing by using the SAVE command, AutoCAD also saves the
previous version of the file as a backup, using the same filename but appending the file
extension .BAK. You can recover the previous version of the drawing by renaming the
backup copy so that it has a .DWG file extension and then loading it into AutoCAD.
These backup copies can consume a considerable amount of disk space, however. If you
decide that you will not need to maintain backup copies of your drawings, you can turn
off this feature from the Open and Save tab of the Options dialog box.

If the drawing has not previously been saved, AutoCAD displays the Save Drawing
As dialog box. Type the drawing name in the File Name text box and then click Save.

To save a drawing using a different name, do one of the following:

■ From the File menu, choose Save As.

■ On the command line, type SAVEAS and then press ENTER.

In the Save Drawing As dialog box, type the new drawing name in the File Name text
box, and then click Save.

As you work, AutoCAD periodically saves your drawing. However, it doesn’t save the
drawing to the current file. Instead, AutoCAD saves the drawing to the file specified by
the SAVEFILEPATH and SAVEFILE system variables, appending the file extension
.SV$. Initially, AutoCAD updates this saved file every 120 minutes. You can change
the name of the file and the interval between periodic updates from within the Options
dialog box. The time interval is controlled from the Open and Save tab. You can also
turn off the automatic save feature from this tab. The location of this saved file is
controlled from the Files tab (under Automatic Save File Location).
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Viewing and Updating Drawing Properties
You can save custom property information, such as the title, author, subject, keywords,
and hyperlink addresses, when you save your drawings. The new Drawing Properties
dialog box lets you save, view, and update this information at any time, making it
much easier to keep track of your drawings.

To display the Drawing Properties dialog box, do one of the following:

■ From the File menu, choose Drawing Properties.

■ At the command line, type DWGPROPS and then press ENTER.

The Drawing Properties dialog box contains four tabs:

■ General Displays the filename, drawing type, location, size, and other
information. Since the information on this tab is derived from the operating
system, all the information is read-only.

■ Summary Enables you to enter the drawing title, subject, author’s name,
keywords, comments, and a hyperlink base (see Figure 1-19).

40 A u t o C A D 2 0 0 2 : T h e C o m p l e t e R e f e r e n c e

Complete Reference / AutoCAD: TCR / Cohn / 222429-0 / Chapter 1

Figure 1-19. You can store the drawing title, subject, author, and other information
in the Summary tab of the Drawing Properties dialog box.
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■ Statistics Displays data such as the date the drawing was created and last
modified and how long the drawing has been edited.

■ Custom Enables you to enter up to ten custom properties. You specify the
names of the fields in the Name column, and specify the value for each field in
the Value column.

You can then use the drawing property information when searching for drawing
files, using AutoCAD DesignCenter or Windows Explorer.

Properties entered in the Drawing Properties dialog box are not associated with the
drawing until you save the drawing.

Exiting from AutoCAD
When you are finished working in AutoCAD, you should exit from the program. To
exit from AutoCAD, do one of the following:

■ On the main AutoCAD title bar, either click the Close button or double-click
the program button.

■ From the File menu, choose Exit.

■ At the command line, type EXIT or QUIT and then press ENTER.

■ Press the ALT-F4 shortcut key combination.

If you haven’t saved your most recent changes for each open drawing, AutoCAD
displays a dialog box for each one, asking whether you want to save the changes to the
current drawing.

Click Yes to save the changes, No to exit from AutoCAD without saving the changes,
or Cancel to remain in AutoCAD.
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If a command is active in any open drawing window, AutoCAD displays an alert dialog
box, informing you that you must first complete the command and then try again.
Switch to the drawing in which the command is active, complete or cancel the command,
and then try to exit from AutoCAD again.

You can use the CLOSEALL command to close all open drawings without exiting from
AutoCAD.
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